
C ra cked Hea t Exchange r

Introduction to the Lesson
This example simulates the stress concentration due to a crack formed between two layers in a
heat exchanger pipe.  A gap such as this severely impedes heat flow.  The resulting temperature
difference creates thermal stresses that tend to propagate the crack along the tube interface. For
this problem the stress is caused by thermal expansion in the pipe.  Thermal expansion is not part
of the structural application in the base FEMLAB software.  It is included in the structural
mechanics module.  In this problem we show how to add thermal expansion to the base
equations.

Key Instructive Elements

The key elements we hope you will learn in this example are 

1 Practice simulating heat transfer and plane stress

2 Adding thermal expansion to Navier’s structural equations

3 Adding mesh near a point to improve the solution accuracy near a singularity

PHYS ICS

Tubes for heat exchangers in pulp mills must stand up to considerably different chemicals on
their inside and outside surfaces. The tubes thus generally consist of two layers, each made of a
different stainless steel. A flaw in the joint between the inner and outer layers, here visible as a
crack, severely impedes heat flow. The resulting temperature difference creates thermal stresses
that tend to propagate the crack along the tube interface.
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In developing a model, note that the thermal and elastic properties of the two steels are similar
enough that you can consider them essentially equal. In addition, you can handle the crack as a
thermal insulator. The restriction that the crack surfaces are constrained and won’t penetrate each
other constitutes a contact condition: If they are separated, the normal force is zero, and if they
are in contact, the normal displacements must be equal, and the normal forces are inward.

At the crack tip there is a singularity in stress distribution, as the stress will highly increase around
that point. To get accurate results a mesh refinement is needed around the crack tip.The
following simulation assumes that the crack surfaces are separated. In other words, set the normal
forces to zero and then compute the displacements. This analysis also assumes that the crack will
propagate according to its opening mode.

The real geometry is a 3D geometry, but it can be simplified as there are several symmetries.
Consider the tube to be long enough so that the strain along the length is null. This means that
you do not need to model the complete 3D geometry, only a 2D cross section using a plane
strain assumption. It is also possible to model only a half of the 2D geometry as there is
symmetry for geometry, loads, boundary conditions, and material.

This model involve both heat transfer and linear stress analysis using the plane strain
assumption.The unknown of the system are:

• u, displacement along x-axis

• v, displacement along y-axis

• T, temperature.The equation of the system are:

• The Navier’s equation including the thermal effect:

where c is the matrix including the Young’s modulus and Poisson’ ratio, α is the matrix
handling the thermal expansion and K the volume forces.

Note: α in the above equation stands for the FEMLAB PDE coefficients and not the thermal
expansion coefficient.

See “The Plane Strain Application Mode” on page 193 in the Modeling Guide for details.

( )c u T Kα−∇ ⋅ ∇ + =
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• The heat equation

∇ k T∇( )⋅– Q=

where k is the thermal conduction and Q the heat source.

Results and Discussion

In the following plot you can see the stress concentration around the crack. The plot 
shows only a smaller range of the stress values (between 26 MPa and 700 MPa). 
Because of the stress concentration, using the complete range for the stresses means 
that you cannot see the stress distribution in all the tube.

With a mesh size of 1 x 10-5 around the crack tip, the analysis shows good accuracy as 
the stress in the immediate neighborhood of the tip has converged. 

You can also see that the crack is opening, a so-called modal deformation.

Modeling in COMSOL Multiphysics

Modeling this system in COMSOL Multiphysics requires coupling two application modes: 
Heat Transfer by Conduction and Plane Strain.

The equations link by adding thermal expansion from the Heat Transfer application 
mode to the solids model given by the plane strain formulation of Navier's equations.
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All displacements result only from the heat source.

The thermal stress can be written as:
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Here the reference temperature will be equal to 0, and D is the elasticity matrix. So we 
have:
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The σx and σy stress should be added to the α coefficient for the equation system in 
the modeling domain. The normal stress variables also need to be edited to add the 
thermal part.

In this model there is a stress concentration due to the crack. At the crack tip the stress 
tends to infinity as the mesh size approaches zero. In the immediate neighborhood of 
the crack tip, the stress must approach a constant value for the model to converge.

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 In the Model Navigator click the Multiphysics button. 

2 Select COMSOL Multiphysics>Heat Transfer>Conduction>Steady-state analysis in the list of 
application modes.

3 Click Add.
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4 Select COMSOL Multiphysics>Structural Mechanics>Plane Strain>Static analysis in the list of 
application modes (do NOT click Add yet!) .

5 Select Lagrange - Cubic in the Element list.

6 Click Add.

7 Select Plane Strain (pn) in the Ruling application mode list. This makes a linear 
stationary solver the default solver.

8 Click OK.

O P T I O N S  A N D  S E T T I N G S

1 From the Options menu, choose Axes/Grid Settings.

2 Enter the following axis and grid settings:

AXIS GRID

x min -0.016 x spacing 0.002

x max 0.016 Extra x

y min -0.012 y spacing 0.002

y max 0.012 Extra y -0.001 0.001

3 Click OK.

4 From the Options menu, choose Constants.

5 Define the following constant names and expressions:

NAME EXPRESSION DESCRIPTION

E_S 21e10 Young’s modulus

nu_S 0.3 Poisson’s ratio

al_S 17.3e-6 Thermal expansion coefficient

rho_S 7870 density

C_S 449 Heat capacity

k_S 82 Thermal conductivity

Tout 100 Outer temperature

Tin 0 Inner temperature

6 Click OK.

G E O M E T R Y  M O D E L I N G

1 Draw a circle centered at (0, 0) with a radius of 0.01.

2 Draw a circle centered at (0, 0) with a radius of 0.008.
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3 Choose Object Properties from the Draw menu. Type 0.0075 in the Radius edit field 
and 0.00055 in the y-center edit field.

4 Click OK to change the radius and center position of the circle.

5 Draw one more circle centered at (0, 0) with a radius of 0.008.

6 Draw a circle centered at (0, 0) with a radius of 0.006.

7 Draw a rectangle with corners at (0, -0.01) and (0.01, 0.01).

8 Select all objects.

9 Choose Create Composite Object from the Draw menu.

10 Type the Boolean expression (((C1-(C2-C3))+C3)-C4)-R1 in the Set formula edit 
field.

11 Clear the Keep interior boundaries check box.

12 Click OK to create the geometry.

The circles centered at (0, 0) form the tube’s basic geometry. The noncentered circle 
creates a crack with a maximum width of 50 µm. The rectangle removes the right half 
of the domain to take advantage of the symmetry along the y-axis.
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P H Y S I C S  S E T T I N G S

Solver Parameters
The default settings for the equation form is the General form, but as this is a linear 
model, you can use the Coefficient form, which makes it easier to enter the 
multiphysics couplings. To change the solution form:

1 From the Physics menu, choose Model Settings.

2 Select Coefficient in the Equation system form list.

3 Click OK.

Boundary Conditions
1 From the Physics menu, open the Boundary Settings dialog box.
2 Select boundary number 1 to 5.

3 Select the Rx check box. This sets the displacement to zero in the x-direction.

4 Click OK.

5 In the Multiphysics menu, select Heat Transfer by Conduction (ht).

6 Open the Boundary Settings dialog box

BOUNDARY 1-5,10-11 6-7 8-9

Type Insulation Temperature Temperature

T0 Tout Tin

 and enter the following settings:

7 Click OK.

Point Settings
When using these boundary conditions, the solution is not unique: stresses and strains 
are uniquely determined, but there is no specification of the rigid-body translation in 
the y direction. To force uniqueness, you need to lock the displacement of one point 
only. On the symmetry line, the condition requires that the x displacement u is zero. 
Therefore it is sufficient to force the y displacement v to zero in one point on this line. 

1 From the Multiphysics menu, choose Plane Strain (pn). 

2 From the Physics menu, choose Point Settings.

3 In the Point Settings dialog box, select point 4.

4 Select the Ry check box. This sets a constraint along the y-axis and hence locks the 
lower right corner of the geometry.

5 Click OK.
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Subdomain Settings
Now apply the material properties on the domain:

1 From the Physics menu, choose Subdomain Settings.

2 In the Subdomain Settings dialog box, click the Material tab and set the following 
material properties:

SUBDOMAIN 1

E E_S

ν nu_S

ρ rho_S

3 Click OK.

4 From the Multiphysics menu, choose Heat Transfer by Conduction (ht).

5 Open the Subdomain Settings dialog box. This time, set the material properties for 
the Heat Transfer application mode:

SUBDOMAIN 1

k (isotropic) k_S

ρ rho_S

Cp C_S

6 Click OK.

7 Choose Equations systems and Subdomain Settings in the Physics menu. Here you can 
couple the two physics by adding the Temperature T in the Navier’s equation in the 
convection coefficient α.

8 Click the α tab and enter in the first column, second and third line, the following 
expressions:

α(2,1) -E_S/(1-2*nu_S)*al_S 0

α(3,1) 0 -E_S/(1-2*nu_S)*al_S

9 Click the Variables tab and add the following expression to the definition of the 
normal stresses (make sure you add them; do NOT erase the existing expressions:

VARIABLE EXPRESSION TO ADD 

sx_pn -E_S/(1-2*nu_S)*al_S*T

sy_pn -E_S/(1-2*nu_S)*al_S*T

sz_pn -E_S/(1-2*nu_S)*al_S*T
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M E S H  G E N E R A T I O N

Because of the singularity on the crack tip, you must increase the mesh density around 
that point:

1 Open the Mesh Parameters dialog box from the Mesh menu.

2 Click the Subdomain tab and type 1e-3 in the Maximum element size edit field.

3 Click the Point tab.

4 Select point number 3.

5 Type 1e-5 in the Maximum element size edit field.

6 Click Remesh and then click OK.



SOLVE  PROBLEM

• This is a linear problem, to speed the solution let us change the solver from nonlinear to
linear:  Choose Solve > Solver Parameters and change the solver from Stationary
Nonlinear to Stationary Linear.  Hit OK.

• Pick Solve > Solve Problem or the Button with the equals sign on it. Once the problem is
solved, you should see the following thermal plot

POSTPROCESS ING AND V I SUAL IZAT ION

• Open Postprocessing > Plot Parameters. On the General page, select the Deformed
shape check box

• Click the Deform tab. Under Deformation data, select Displacement (pn) in the
Predefined quantities list.

• Click the Surface tab and select von Misses stress (pn) in the Predefined quantities list
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under Surface data. Due to the stress concentration on the crack tip the automatic range is
not suitable.   Click Range. Deselect the Auto check box and type 7e8 in the Max edit field.
Click OK to set the range and again hit OK to apply the postprocessing. You should see 

• Pick Postprocessing > Plot Parameters and then the Contour Tab.  Select the Contour
plot checkbox in the upper left corner and enter min(mises_pn,5e8) as the expression,
Hit OK.  Zoom in on the top of the geometry.

RESULTS  AND D I SCUSS ION

In the plots above you can see the stress concentration around the crack. The plot shows only a
smaller range of the stress values (between 26 MPa and 700 MPa). Because of the stress
concentration, using the complete range for the stresses means that you cannot see the stress
distribution in all the tube.With a mesh size of 1e-5 around the crack tip, the analysis shows
good accuracy as the stress in the immediate neighborhood of the tip has converged. You can
also see that the crack is opening due to thermal deformation.
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